The Kajongg Handbook

Wolfgang Rohdewald
## Contents

1. Introduction ......................................................... 7
2. The Screen Layout .................................................. 8
3. Scoring a Manual Game ............................................. 10
   3.1 Entering hand results ........................................... 11
   3.1.1 Scores ....................................................... 11
   3.1.2 Enter the score manually .................................... 11
   3.1.3 Have Kajongg compute the score .......................... 11
   3.2 Penalties ...................................................... 12
4. Playing .............................................................. 13
   4.1 Play against the computer ...................................... 13
   4.2 Play with friends ................................................ 13
   4.2.1 Caveats ...................................................... 14
   4.3 Game rules ..................................................... 14
   4.3.1 The aim of the game ........................................ 14
   4.3.2 The course of the game ..................................... 15
   4.3.3 Year, Round and Hand ...................................... 15
   4.3.4 Bonus tiles .................................................. 15
   4.3.5 Scoring ...................................................... 15
   4.4 How to play with Kajongg ...................................... 16
5. Interface Overview .................................................. 17
   5.1 Menu Items ..................................................... 17
6. Game Configuration .................................................. 20
   6.1 Play options .................................................... 20
   6.1.1 Sound ....................................................... 21
   6.2 Tiles options ................................................... 23
   6.3 Background options ............................................ 23
   6.4 Ruleset Editor .................................................. 24
   6.4.1 Rule, Points, x2, Limits .................................... 24
   6.4.2 Copy and Remove .......................................... 24
   6.4.3 Compare ..................................................... 25
   6.5 Default Keybindings ............................................ 25
The Kajongg Handbook

A  Known problems  
B  Possible future features  
C  Frequently asked questions  
D  Credits and License  
E  Bibliography  
F  Installation
List of Tables

6.1 Sound file names ......................................................... 22
Abstract

This documentation describes the game of Kajongg
Chapter 1

Introduction

**Game Type:**
Board, Arcade

**Number of Possible Players:**
Four

Kajongg is a board game created after the famous oriental game of Mah Jong (from Chinese *májiāng*). It is played by four players. Worldwide many different rule sets are in use. Right now Kajongg supports the Classical Chinese rules as played in Germany, eventually other main rule sets will follow. It is possible to customize or add new rulesets. Please do so and send them to the program author for integration!

Kajongg can be used in two different ways: Scoring a manual game where you play as always without the help of a computer and use Kajongg for the computation of scores and for bookkeeping. Or you can use Kajongg to play against any combination of other human players or computer players.
Chapter 2

The Screen Layout

A quick explanation of the parts of the game screen.

**Toolbar**

The Toolbar is located beneath the menubar and contains buttons for the most often used actions. The content of the Toolbar can be edited. You can also make it invisible, giving more room to the Board.

Depending on the size of your screen you may want to make the toolbar invisible or to move it to the left side of the window. You can do that by click with the right mouse button on the toolbar.

**Board**

The Board is the largest section of the window. You see the four walls with a length of 18 tiles (the exact number depends on the rules like using bonus tiles or not). The names of the players are written on the walls, together with the current value of the hand (as far as known) and their wind tiles. The prevailing wind has a coloured background, east in the screenshot above.
The Kajongg Handbook

When playing, the interior of the walls holds the tiles discarded by the players. They are randomly placed. The last discarded tile has a blue focus frame.

When scoring manual games, the interior of the walls has a selection of all available tiles, the central selector. You can assign them to the players using the mouse or the keyboard.

**Player Region**

Every player has a screen range for her tiles. The upper row contains exposed tiles, the lower row concealed tiles. When scoring manual games, concealed tiles are shown with a shadow over the entire tile. Bonus tiles go to the right end.

**Dialog**

The dialog presents choices the player has. Most often it has a timeout with a progress bar showing the remaining time.

**Status bar**

The Status bar is located at the bottom of the screen and contains the current totals for the players.
Chapter 3

Scoring a Manual Game

In this mode, Kajongg is only used to do the scoring. You play as usual with real people on a real table and at the end of a game you can tell Kajongg the tiles a player has in her hand and everything else Kajongg needs to know for calculating the scores - which is what the program will do. Alternatively you can calculate the hand scores manually and enter them. Kajongg will then make the payments amongst the players and write the results into a data base. It is possible to suspend a game, start another game with other players and resume old games. All rules will be saved together with the games, so different games can be played with different rules.

- From the menu, select Game → Score Manual Game or press Ctrl+C.
- Now you can either select an existing unfinished game or start a new game. If you start a new game, you will be asked for the players and the ruleset. Kajongg will propose the same values used for the previous game. If there was no previous game, it will propose the first four defined players. Please note that you cannot change the ruleset or any of its rules after this selection. You can do that beforehand in the ruleset editor.
- Now you get a new window titled Scoring for this Hand. Read Have Kajongg compute the score for a detailed description.
- After saving hand results, continue with the next hand.
3.1 Entering hand results

3.1.1 Scores

This is the window for entering hand results. It automatically shows itself when Kajongg thinks you might need it. You can always show or hide it by pressing Ctrl+S or by selecting the corresponding menu entry.

As always the prevailing wind has its background colored.

Here you can manually enter scores for all players. Alternatively you can exactly define which tiles a player had in her hand. If you choose to do that, the corresponding field for the manual score value will be grayed out. Kajongg will automatically compute the score.

After having entered all relevant data for a hand, press the button Save Hand. The hand values will be entered in the database, and they are also shown in the score table. You might be prompted to change the seating positions of the players but you can choose not to change seats. The proposed changes are currently not customizable - if a ruleset needs something different, we will change that.

If the player might have won, the check box in the column Winner will be enabled - click this for the winner.

The status bar will now show the updated balances for the players, and you can continue with the next hand.

3.1.1.1 Enter the score manually

A good player will probably prefer to compute her score himself. In that case you can directly enter it. This is only possible when no tiles are selected for this player.

If you enter a manual score, it must already contain everything except penalties, you will have no optional rules to choose from. There is one exception: ‘Dangerous Game’. This does not influence any scores, it is no offense either. It only means the payment between players is different: The offender pays all for all to the winner. The other two players do not exchange payments. This is currently not customizable.

3.1.1.2 Have Kajongg compute the score

If you explicitly tell Kajongg what tiles a player holds, entering scores will be grayed out for that player in this window. While associating tiles with a player you will see how her score will grow.
- but as soon as you add the 14th tile the score goes to zero. That might surprise you but unless you declare this as the winner hand, it is recognized as a long hand which always has zero points. This behaviour is defined by the Classical Chinese ruleset, it might be different if you change the rules or use a different ruleset.

You can associate tiles and melds with a player using either the mouse or the keyboard or both. With the mouse simply move tiles by dragging/dropping them to the player region. When dropping the tile, you will be asked what you want to move: Single, Pair, Pung, Kong, Claimed Kong or Chow. The upper row is for exposed tiles, the lower row for concealed tiles. The bonus tiles will appear to the far right. You can also move tiles and melds between rows, between players and back to the central selector.

If you prefer using the keyboard, you can use Tab to move between the central selector and the player regions. The keys eswnESWN move a tile to the players East, South, West and North. The keys xX move it back to the central selector. ESWN moves to the concealed row, eswn moves to the exposed row. You can move the cursor between tiles or melds using the arrow keys, the currently selected tile or meld has a blue frame. Since the key arrows are far away from letters on the keyboard, you can also use the letters hjkl or HJKL for moving the cursor. hH move left, jJ move down, kK move up, lL move right. This is how the unix editor vi does it. The KDE browser Konqueror and even this help program also support those keys in the same way. Those keys may differ if you use a language other than English but it is currently not possible to configure them.

The options Last Tile: and Last Meld: are needed by some rules like Last tile completes pair. They can only be used for the winner hand.

In the right part of the window you can manually apply some rules. What rules appear in this list depends on the current ruleset and on the tiles. In the example of the above screen shot, the losing players might have an option ‘dangerous game’ - again depending on the ruleset and on their tiles. It is the aim of the developers to keep this list of manually selectable rules as short as possible. Optimally Kajonggg should always be able to automatically determine whether a rule applies, but sometimes Kajonggg does not have enough information or knowledge to decide.

### 3.1.2 Penalties

![Penalty Window](image)

In the window for entering hand results, the Penalties button will bring up this window where you can enter penalties. This can be done at any point in time independent of the normal scoring mechanism.

The Offense: selection shows all offenses that might be applicable to the hands the players hold. Choose among them.

Now you can adapt the Total Penalty. This is the total sum that is moved from payers to payees. It will be evenly split between them.

Depending on the type of offense, the number of payers and payees varies. The right number of players is displayed. If you select a player, Kajonggg ensures that this player only occurs once by adapting the other players.
Chapter 4

Playing

At any time, you can enable or disable the Demo Mode. In Demo Mode, the computer will play for you. If no game is currently played, a new game will be started with the last used ruleset.

4.1 Play against the computer

First you will get a login dialog. Enter the game server you want to connect to and your user name. If you choose the special entry Local Game, you only need to enter your name (or accept the proposed name) and the wanted ruleset. This will immediately start a local game where you play against 3 robot players. However if suspended games exist, they will be displayed in a list. You can then select the game you want to continue with or start a new game.

4.2 Play with friends

If you want to play against other real people, you need a game server to which all players, including yourself, need to connect. Do that by selecting any other host or by manually entering a new host name and by specifying your password for that host. The last used password will be proposed.

The easiest way is to use the game server at kajongg.org. Kajongg will show this one in the list of possible game servers. Please note that this server only offers a game server but no web page or any other services.

If you do not have an account on the game server with the name you entered, you will be asked if you want to open an account. If you say yes, you will get a new dialog where you can enter the wanted password twice. Your account will be created automatically.

After a successful login onto the game server, you will get a list of tables with available seats on that game server. Join a table or allocate a new table. If you allocate a new table, wait until more seats are taken by other players. You can start the game on a table you allocated at any time, the seats not taken will be filled by robot players.

The table list also shows the name of the ruleset played on that table. The ruleset and its name are sent to the game server by the player initiating the table. If you have an identical ruleset, the table shows your name for the ruleset - this might be helpful if the table initiator speaks another language and named the ruleset differently. Also, if the name of your local ruleset is displayed, it is displayed in black. If however you have no identical ruleset, the name appears in red, and you can use the button Compare to compare it with your own rulesets.

If you do not use kajongg.org or any other existing game server, you can start your own Kajongg game server in two different ways:
connect to the server localhost. This is your own computer. If you do this and no game server is running, it will be started automatically. And when you stop playing, the server will be stopped too. This differs from selecting Local Game, the latter does not allow connections from other computers.

- manually start a server on any computer you want. All you need to do is go to a command line and start the program kajonggserver. Entering kajonggserver --help will show you all available options like changing the default port. This server will run until you kill it.

In both cases you need to tell the other players how they can reach your game server. They need the URL or simply an IP address and the port your server is listening on. This might be something like mypc.dyndns.org:8301 where 8301 is the port. Of course you need to configure your firewall such that the remote player can reach that port. The communication will be encrypted.

For the port number, please see Help → About Kajongg. The Protocol version is the port number. For Kajongg 17.04 this is 8301. If the player enters no port for the wanted game server, the client computes the port in the same way. So if a computer runs several game servers with different protocol versions, you should normally reach the correct game server automatically. Anyway the game server and the client will make sure that their versions are compatible and warn you otherwise.

If you encounter possible bugs, you might want to use the option kajongg --debug=traffic. This will show you, on the console where the game server has been started, what messages are flowing between the game server and the clients. For more options, see kajongg --help

### 4.2.1 Caveats

- If you want to make sure nobody can cheat none of the human players should have access to the computer the game server is running on. Of course you can never avoid that two players help each other because you cannot know what they really are doing. Two players might even be one and the same person.

### 4.3 Game rules

Worldwide, many different game variants exist. Currently, Kajongg supports two variants of Classical Chinese, one as played in Germany and one as played in Great Britain.

This description does not go into details and as such matches both variants.

However most of the basic rules are the same in most variants.

Since the program Kajongg knows how to play, this description only contains things that might not be obvious.

If you want to learn Mah Jong in more detail, please consult the bibliography.

#### 4.3.1 The aim of the game

Each player tries to collect tiles such that she has a winning hand. On achieving this, she calls 'Mah Jong'. In a winning hand, the tiles are normally grouped into five melds: Four melds with three or four tiles each and a fifth meld consisting of two equal tiles. A normal meld has three or four identical tiles (called Pung and Kong respectively) or three successive tiles like Bamboo 3, Bamboo 4, Bamboo 5 (called Chow).
4.3.2 The course of the game

Initially, the player with the East wind (as indicated on the wall) has one more tile than the other players. East begins by discarding an unwanted tile.

Whenever a tile has been discarded, other players can claim it by saying what they can complete with that tile (Chow, Pung, Kong, Mah Jong). Only the next player can claim a Chow - the other claims are possible for all players. A meld completed by a claim will be exposed - made visible to all players.

If nobody claims the discarded tile, the next player, South (and then West and North) gets a tile from the wall and discards an unwanted tile.

There are several rules about when a Pung can be extended to a Kong (by claiming the forth tile or by getting it from the wall) - these rules are not explained here. But Kajongg of course knows them and makes sure they are respected. If a Kong is declared, the player automatically gets a replacement tile from the wall - otherwise it would not be possible to build the five melds as mentioned above.

4.3.3 Year, Round and Hand

When a player claims Mah Jong or we end up in a draw, a hand is completed. Now, except for draws, the winds rotate among the players. This is repeated until every player once had every wind. This entire unit is called a round. An entire game, also called year, consists of four such rounds: East wind round, South wind round, West wind round, North wind round. The wind of a round is also called prevailing wind, it can result in higher scores.

So a full game (a year) consists of at least 16 hands. Since the winds do not rotate for draws or when the East player says Mah Jong, a higher number of hands is normally needed for a full game.

4.3.4 Bonus tiles

A game can contain eight bonus tiles (unless the rules exclude them). They are exposed separately on the right side of the player region as they are never used for building melds. They do however generate bonus points.

If a player gets a bonus tile, she will automatically also get a replacement tile from the wall. And a bell rings.

4.3.5 Scoring

At the end of a hand, the score for each player is computed. First, basis points are counted like 2 points for a simple exposed pung or 20 points for winning. Next, another set of rules is applied - those rules can double the points like one double for a meld of dragons. When the score for each hand is known, differences are paid between players - while the winner gets its full score paid from all other players. East always gets and pays twice her score.

Of course Kajongg knows about all applicable rules but a good player knows what combinations get what score so she can optimize. While learning it is recommended to activate the window Explain Scores.

The exact scoring rules often vary - in Kajongg you are free to change them with the ruleset editor.

The ruleset editor also shows you all available rules and their meaning. Place the mouse over them and for the more exotic rules help text will appear.
4.4 How to play with Kajongg

You will be prompted for what you want to do. This is a little dialog which appears either on the right or at the bottom depending on the size of the window. If you make it broader than high, the dialog appears on the right. Sometimes the dialog will have a timeout - when it is over, the first possible answer is automatically selected for you. This timeout is configurable in the Ruleset Editor, under Options, Claim Timeout. All players should have the same timeout, that is why this is part of the ruleset.

If you need to select a tile from your hand, you can move between tiles using the Right and Left arrow keys or the letters h and l on your keyboard. Of course you can use the mouse too.

You can discard a tile by using the keyboard the same way as for all actions. Alternatively, you can use the mouse and move the tile from your hand into the discard area (the interior of the walls). The placement of the tile in the discard area will still be done by the computer - because the placement should be the same for players.

Often, the dialogs will offer choices which are not really applicable like calling Pung when you do not have the needed tiles. This is intended - just like in a real game. But you can configure impossible choices away: Disable Show only possible actions on the Play page of the settings dialog.

Discarded tiles are placed randomly between the walls. Some game variants define where the tiles should be placed, this is not yet configurable however. When it becomes configurable, it will be part of the ruleset.
Chapter 5

Interface Overview

5.1 Menu Items

Game → Score Manual Game (Ctrl+C)
Only score a manually played game.
You can load an old game or start a new game. By default only pending (i.e. unfinished) games are shown in the selection list. You can optionally show all games including finished games. Here you can also delete games.

Game → Play (Ctrl+N)
Play with others (people and computers).

Game → Abort Game (Ctrl+W)
Abort the current game. If it was a manual game with scoring only, you can resume it later.
If you played using Kajongg, the game is not yet resumable.

Game → Quit Kajongg (Ctrl+Q)
Quits Kajongg.

View → Chat (Ctrl+H)
Chat

Chat on table 1 at localhost - kajongg

<table>
<thead>
<tr>
<th>Time</th>
<th>Player</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>07:54:34</td>
<td>Wolfgang Rohdewald</td>
<td>opens a chat window</td>
</tr>
<tr>
<td>07:55:09</td>
<td>Jim</td>
<td>takes a seat</td>
</tr>
<tr>
<td>07:55:19</td>
<td>Wolfgang Rohdewald</td>
<td>Hi Jim</td>
</tr>
<tr>
<td>07:55:19</td>
<td>Jim</td>
<td>opens a chat window</td>
</tr>
</tbody>
</table>

Lets you chat with the other players.
The Kajongg Handbook

View → Score Table (Ctrl+T)

Score Table

Show the score table. Round/Hand are the current round (East, South, West, North) followed by a count of the hands played in that round. The winner has a green background for her values. The Payments show how much the player paid to or received from all other players with this hand. The Balance shows the current balance for all players. The Chart shows the development of the balance values. The hints give you more details: They show all rules that have been applied to this hand. Just move the mouse over the value you are interested in.

The lower part shows the used ruleset. Between the score table and the used ruleset you can find a splitter letting you change the relative sizes of both parts.

View → Explain Scores (Ctrl+E)

Explain Scores
The Kajongg Handbook

Explains how the score for the current hand was computed.

View → Full Screen Mode (Ctrl+Shift+F)
Switches between full screen mode and normal mode.

Settings → Players
Add, modify and delete players.
The passwords in this table are those used by default when logging onto a game server. Changing the password you initially chose for a game server is not yet really helpful because there is no way yet for you to also change your password on the game server. You would have to ask the administrator of the game server to do that for you directly in the data base.

Settings → Rulesets
Customize rulesets.
Use the Ruleset Editor to customize rulesets. For details see here.

Settings → Change Visual Angle (Ctrl+G)
Changes the viewing angle of the tiles counterclockwise.

Settings → Demo Mode (Ctrl+D)
Enables or disables the Demo Mode. See here for details.

Additionally Kajongg has the common KDE Settings and Help menu items, for more information read the sections about the Settings Menu and Help Menu of the KDE Fundamentals.
Chapter 6

Game Configuration

The menu entry Settings → Configure Kajongg... opens the Configure - Kajongg dialog. If you press the Cancel button here, all of your configuration changes will be reverted, including everything you did with the ruleset editor.

You can also select the different tabs with the keyboard: Ctrl+1 selects the first tab Play options, Ctrl+2 selects the second tab, and so on.

6.1 Play options

Show tile shadows
This shows tiles with borders and shadows. Also there is some space between tile rows, and the wall tiles are shown such that you can see that the wall is two or three tiles high. So if you disable this option, you have a simpler display with slightly larger tiles. This may be helpful for small screens.
Rearrange undisclosed tiles to melds

This groups melds in the hand. Sometimes the grouping might not be like you want it, so you might prefer to have no grouping at all, just like in a real world game.

Show only possible actions

When playing, show only possible actions like ‘No claim’ or ‘Pung’.

Propose what to do

Whenever you have a choice of actions like claiming a tile or not or like choosing which tile to discard, Kajongg can help you by making a proposal.

Use sounds if available

This lets you hear discards and claims. If other players recorded sound files with their own voice, you can hear them.

Let others hear my voice

If you recorded sound files with your voice this option will let the other players hear your discards and claims with your voice.

Animation speed:

Define how fast the tiles should move around. If you move the slider to the rightmost position, tile movement is not animated: the tiles will simply change place.

6.1.1 Sound

Playing gives you a much nicer experience if you hear players claim tiles and announce discards. It also makes playing easier because you can concentrate on your own tiles, you do not have to watch what others discard.

Kajongg comes with voices for different players. It automatically assigns voices to players. For every language there should be four voices, preferably two male and two female. Kajongg tries to use voices in the same language Kajongg runs in. If it finds no voices in that language, Kajongg will fallback to other languages, using the same fallback languages you defined for Kajongg (see Help → Switch Application Language). If no voice files exist yet for your language, you are invited to record and contribute them to Kajongg.

• This is how you can generate voices yourself. There is a separate folder for every voice. Please note that those folders may be somewhere else on your system, they depend on how KDE was installed. Only the part starting with kajongg is always the same. There are two groups of voices with different places in the file system:
  – Predefined voices for every language. They live in a folder like /usr/share/kajongg/voices/LANG where LANG is the code for your language. The voice directories directly under ../.. are the US-english versions. Predefined voices are randomly assigned to players. Those voices have names like 'male1 male2 female1 female2’ but those names do not matter, the user will never see them.
  – User voices can be defined for a specific user. If Kajongg makes use of such a voice, it can automatically be transferred to other players over the internet. Those voices live in a folder like ~/.local/share/apps/kajongg/voices/. So if your login name is joe, this might be /home/joe/.local/share/apps/kajongg/voices/joe/. The folder voices/ might not yet exist - if so, create it.

• Now that you know where to place your new voice, generate a new folder for it.

• In that subfolder, you can place the sound files. They have to be encoded with the Ogg Vorbis audio compressor, the file names need to have the extension .ogg. A single file has a name like s3.ogg - this is Stone 3. You should define such files for all tiles and for all claims and announcements. But if a sound file is missing, nothing bad happens - you just will not hear that sound. Fallback to other voices or languages only works for entire voices, not for single sound files.
After having defined all sound files for a predefined voice, please make sure that the Kajongg process has write permission in the new voice folder. Start Kajongg and test the voice. After everything is OK, you can revoke write permission (and you should do so for predefined voices). Kajongg will automatically generate a file named `md5sum` containing a checksum over all sound files. Whenever you change, add or delete a sound file for a voice, Kajongg will try to rewrite that file.

Please make the length of the sound short but speak clearly - this game can be played very fast when you get used to it. It is easier if you first write down a list with everything that should be spoken. Do not read it as a sequence of items, try to pronounce each item as if it were the only one and as you would when playing. Leave room between the items. Reading this needs a little practicing.

This is just one possibility to create the sound files:

- Record a sound file with the program `qarecord`, save it in the WAV format. In this single sound file, speak all of the sounds.
- Edit that file with the sound editor `audacity`. In that editor, use the mouse to mark a range of the sound waves. The editor will play that part. Repeat until you have the correct part selected. This may be easier if you View → Zoom In. Use the menu command File → Export Selection and save in the `.ogg` format. Under Options, choose low quality - this is sufficient and even wanted because this reduces the time to transfer the sounds to the other players.

The following are the names of the files that you should generate. Always append `.ogg` to them:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><code>s1</code> .. <code>s9</code></td>
<td>Stone 1 to Stone 9</td>
</tr>
<tr>
<td><code>b1</code> .. <code>b9</code></td>
<td>Bamboo 1 to Bamboo 9</td>
</tr>
<tr>
<td><code>c1</code> .. <code>c9</code></td>
<td>Character 1 to Character 9</td>
</tr>
<tr>
<td><code>we</code> <code>ws</code> <code>ww</code> <code>wn</code></td>
<td>The winds East, South, West, North</td>
</tr>
<tr>
<td><code>db</code> <code>dr</code> <code>dg</code></td>
<td>The dragons blue/white, red, green</td>
</tr>
<tr>
<td><code>chow</code> <code>pung</code> <code>kong</code> <code>mahjongg</code></td>
<td>The major claims</td>
</tr>
<tr>
<td><code>originalcall</code> <code>violatesoriginalcall</code></td>
<td>Original Call and its violation</td>
</tr>
<tr>
<td><code>dangerousgame</code></td>
<td>A player lets off a cannon (dangerous game)</td>
</tr>
<tr>
<td><code>nochoice</code></td>
<td>A player declares he has no choice but to play dangerous game</td>
</tr>
</tbody>
</table>

Table 6.1: Sound file names
6.2 Tiles options

Use the Tiles selector to select graphics for the tiles.

6.3 Background options

Use the Background selector to select a background graphic for the game.
Some backgrounds like the Chinese Landscape need some time to load. If you feel that the program should start faster or that resizing the main window takes too long, you might try some other background.

### 6.4 Ruleset Editor

![Ruleset Editor](image)

Use the Ruleset Editor to customize rulesets. Predefined rulesets are shown in an italic font, customized rulesets have a normal font. Predefined rulesets cannot be changed by the user in any way, however an update of Kajongg might. Customized rulesets will never be affected by an update.

When starting a new game, you will be able to select a ruleset for that game. All rulesets defined in the ruleset editor can be used. The ruleset is saved together with the game, so you can always change rulesets here - your changes will only affect future games.

#### 6.4.1 Rule, Points, x2, Limits

Simply double click on whatever you want to change. If all values are cleared, this rule will have no influence on the game. Rules cannot be deleted.

#### 6.4.2 Copy and Remove

You can copy and remove entire rulesets.

Again this can even be done if existing games use this ruleset since every game has its own ruleset copy. You can view rulesets for old games: Load the old game and show its score table.
6.4.3 Compare

You can select this command when an entire ruleset is selected. It lets you compare the selected ruleset against any other ruleset.

6.5 Default Keybindings

The default shortcuts are as follows:

F1
Displays this handbook.

Ctrl+C
Score a manual game.

Ctrl+N
Play a game with friends or computer players.

Ctrl+W
Abort the current game.

Ctrl+Q
Quit the program.

Ctrl+T
Show the score table.

Ctrl+H
Show a chat window.

Ctrl+G
Change the viewing angle.
The Kajongg Handbook

**Ctrl+D**
Enables or disables the Demo Mode.

**Shift+F1**
What’s this? help.

**Ctrl+Shift+F**
Full Screen Mode.
Appendix A

Known problems

• In playing mode, penalties are not yet possible.
• The computer players are still rather stupid.
Appendix B

Possible future features

- Add more rulesets. This should optionally be done by people using those rulesets regularly.
Appendix C

Frequently asked questions

1. *I want to change the way this game looks. Can I?*
   
   Yes. To change the way Kajongg looks use the menubar to open the configuration utility.

2. *Can I use the keyboard to assign tiles to players?*
   
   Yes. See Have Kajongg compute the score.
Appendix D

Credits and License

Kajongg for KDE
Program Copyright (c) 2009-2017 Wolfgang Rohdewald wolfgang@rohdewald.de
Documentation Copyright (c) 2009-2017 Wolfgang Rohdewald wolfgang@rohdewald.de
This documentation is licensed under the terms of the GNU Free Documentation License.
This program is licensed under the terms of the GNU General Public License.
Appendix E

Bibliography

- Das Chinesische Mah-Jongg-Spiel by Uwe Martens 2005, Books on Demand GmbH, Norderstedt. This book is an excellent German reference containing everything you want to know about the rules used in Germany and many other aspects of the game.

- The Complete Book of Mah-Jongg by A. D. Millington, 1977 (with several paperback editions up to 2003), Weidenfeld & Nicolson, London. This is the ultimate reference for Classical Chinese Mah Jong as played in the Western world. It can give you valuable hints about game strategies.


- https://en.wikipedia.org/wiki/Mahjong
- https://de.wikipedia.org/wiki/Mah-Jongg
Appendix F

Installation

For Linux: Your distribution should have it packaged for you.


If you want to download the source and install manually:

- git clone https://invent.kde.org/games/kajongg.git
- For Linux: cd kajongg ; mkdir build ; cd build; cmake .. && make && make install
- For Windows: Please read README.windows

Kajongg depends on those packages: (debian package names in parentheses)

- Python 3.5 or higher (python3)
- Qt5.7 or higher (python3-pyqt5 and python3-pyqt5.qtsvg)
- the python bindings for Qt5 (python3-pyqt5)
- the python twisted library 16.6.0 or higher (python3-twisted)
- sqlite3 (libsqlite3-0)